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Purpose: The main purpose of this study was to provide an estimation of the committed 

effective dose received by the Swedish population from naturally occurring 

radionuclides (NORM) in the diet. This study was also aiming to investigate the 

impact on the committed effective dose due to the new developments in the biokinetic 

model for Po210 . In addition to dose estimation, this project was also aiming to 

investigate how to make interpolation maps using the software ArcGIS.  

 

Background 

& theory:   

In previous studies of radioactivity in food, the focus has been on anthropogenic 

radionuclides. Even though NORM in food is contributing to a larger committed 

effective dose than anthropogenic radionuclides, no detailed assessment of the 

committed effective dose from NORM to the Swedish population has been done. For 

Po210 , which is an important radionuclide for the committed effective dose from the 

diet, new developments have been done in the systemic model. One of the new 

developments include an additional excretion pathway, via hair and sweat.  

 

Method: Activity concentrations of Po210 , U234  and U238  in various food and foodstuff were 

collected from the ongoing research projects Radiological Implications of Swedish 

Food Consumption and Natural radioactivity in the Nordic diet. Committed effective 

doses were calculated for adults and children of three age groups. Comparisons were 

made of committed effective doses received by Swedish men vs. women and also 

lacto-ovo vegetarians vs. people including animal protein in their diet.  

 

The investigation of the impact on the committed effective dose from Po210  due to 

new developments in the biokinetics was done using the softwares IMBA, SAAM II 

and Ecolego. In IMBA, the impact on the committed effective dose was simulated by 

varying the GI uptake fraction, the tissue weighting factors and the transfer rate 

between stomach and small intestine. In SAAM II and Ecolego, the biokinetics of 

Po210  was simulated using the Human Alimentary Tract Model and the updated 

systemic model. By using the methodology in ICRP 133, the committed effective dose 

coefficient was calculated and compared with the coefficient from ICRP 119.  

 

The interpolation of dose rate data was carried out in the software ArcGIS 10.6, using 

the Empirical Bayesian Kriging method.  



 

Results & 

conclusion: 

 

The committed effective doses received by adults and children were 77 ± 2 µSv/y 

and 94 ± 9 µSv/y, respectively. The Swedish men receive a 20% higher committed 

effective dose than the Swedish women. Diet including animal protein results in a 4.5 

higher committed effective dose from Po210  than lacto-ovo vegetarian diet. The 

overall effect of cooking of food is a reduction of the levels of Po210 .   

 

By varying the GI uptake fraction, the estimate of the committed effective dose from 

Po210  differed by ± 9% from the dose calculated using the GI uptake fraction defined 

by ICRP. When using the tissue weighting factors from ICRP 133, the estimate of the 

committed effective dose from Po210  was 23% higher than the dose calculated using 

the weighting factors from ICRP 68. When using the sex dependent transfer rates, a 

higher committed equivalent dose to stomach was estimated for women than men.  

 

The simulation of biokinetics of Po210  suggested that the new developments in the 

biokinetic models is leading to a 5-18% higher estimation of the committed effective 

dose from NORM in food received by Swedish adults.  

 

Measured values were compared with predicted values in the interpolated dose rate 

map. Good agreement was found, suggesting that the Empirical Bayesian Kriging 

method works well for this purpose.  
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Introduction 

Natural radionuclides are occurring in all types of food and foodstuff. The radiation 

source that food constitutes is rarely concerned as a health risk due to the very low levels of 

radionuclides [1]. Large variation in the levels of radionuclides are though present in different 

geographic locations, depending on geology, agriculture procedures and climate. In previous 

studies, the focus has been on anthropogenic radionuclides in food and not so much on naturally 

occurring radionuclides (NORM), despite the fact that NORM in food contribute to a higher 

committed effective dose than the man-made radionuclides.  

The annual effective dose received from all natural sources is on average 2.4 mSv for 

the world population [2]. This includes exposure from radionuclides in bedrock and soil, in 

food, water and air, cosmic radiation and radionuclides in our bodies. Considering the artificial 

exposure (dominantly of medical origin) as well, the total committed effective dose to the world 

population is on average 3 mSv per year. Food consumption is contributing to 0.29 mSv of the 

yearly dose from natural exposure [3]. The reference level for ingestion doses are set to 1 mSv 

[1].   

The Swedish population is receiving a total annual effective dose of 3.7 mSv to the 

whole population and 2.4 mSv to never-smokers (2007) [4]. The contribution from NORM in 

food and foodstuff is 0.2 mSv. For reindeer keepers, the total annual effective dose is 3 mSv. 

This is due to the additional contribution from NORM in food of 0.8 mSv and the contribution 

from the Chernobyl fallout of Cs137  in food. The annual effective dose received from Cs137  is 

0.18 mSv for reindeer keepers and 0.025 mSv for the whole population.  

The International Atomic Energy Agency (IAEA) is working on producing a guide for 

NORM in food, to complement the existing guides for anthropogenic radioactivity occurring in 

food [1]. This guide will consist of activity concentrations in various food and foodstuff, 

information about when higher levels might appear and information about food that contain 

high activity concentration.  
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Background 

Previous research 

In 2017, a study of the annual committed effective dose received by the Norwegian 

people was carried out. Food was contributing to 10% of the total annual committed effective 

dose, where 98% was due to radionuclides of natural origin [5]. The radionuclides that were 

considered to contribute to the committed effective dose were the naturally occurring Po210 , 

Ra228 , Rn222 , K40 , Pb210 , C14 , Ra226  and the anthropogenic Cs137 . The highest committed 

effective doses came from Po210  and K40 .  

Other NORM that have been found to be important for the committed effective dose are 

U238 , U234 , Th230 , Th232 , Th228  and Ra224  [6].  

Different habits in food consumption can result in higher exposures of certain groups of 

the population. In the study of the Norwegian diet, the groups examined were the whole 

population and the special groups that eat high amounts of reindeer meat, sheep meat, wild 

products (game meat, mushrooms, berries) and seafood [5]. The exposure scenario that 

contributed the most to the committed effective dose was high consumption of Cs137  

contaminated reindeer meat. Po210  in reindeer meat and in seafood was also found to play an 

important role for the committed effective dose.  

The annual effective dose received from the uranium and thorium series in food is 0.12 

mSv to adults in the world population, where Po210  is the radionuclide contributing the most 

[7]. Table 1 shows the annual effective dose to the world population received from 

radionuclides in the uranium and thorium series in food.   

 

Table 1: Annual effective dose to the world population from radionuclides in the uranium and thorium series in food [7]. 

Radionuclide Committed effective dose [µ𝑆𝑣/𝑦] 

Infants (1 year) Children (10 years) Adults 

U238  0.23 0.26 0.25 

U234  0.25 0.28 0.28 

Th230  0.42 0.48 0.64 

Ra226  7.5 12 6.3 

Pb210  40 40 21 

Po210  180 100 70 

Th232  0.26 0.32 0.38 

Ra228  31 40 11 

Th228  0.38 0.30 0.22 

U235  0.011 0.012 0.012 
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The annual effective dose to the world population from NORM in food is on average 

0.29 mSv, where 0.12 mSv is received from the uranium and thorium series and 0.17 mSv is 

received from K40  [3].  

 

Present research  

Radiological Implications of Swedish Food Consumption is an ongoing research project 

performed at the University of Gothenburg, funded by the Swedish Radiation Safety Authority 

(SSM). The purpose of the project is to estimate the levels of anthropogenic and natural 

radionuclides in the Swedish diet. In the project, a database of radioactivity levels in foodstuff 

will be performed and the radiological risk due to consumption will be estimated. Mixed diets, 

such as in kindergartens, schools and hospitals will be studied and critical groups will be 

identified. A study of the origin of foodstuff will also take place, as well as a comparison 

between radionuclide levels of natural and anthropogenic type. The project aims to determine 

the fraction of the annual effective dose contributed by food consumption.  

The samples of foodstuff will be collected at different locations in Sweden and imported 

food will be considered as well. The samples include milk products, cereals, vegetables, fruits, 

meat, fish and other foodstuff. Studies will be performed to examine seasonal differences. Wild 

food will also be included such as game, mushrooms and berries.  

Natural radioactivity in the Nordic diet (NANOD) is a present research project 

performed as a collaboration between the Nordic countries, supported by Nordic Nuclear Safety 

Research (NKS). The aim of this project is to extend the knowledge of the levels of NORM in 

seafood and the committed effective dose received by the Nordic population due to seafood 

ingestion. The project is of importance because of the high levels of NORM in seafood in 

combination with the high consumption of fish and shellfish in the Nordic countries. In the 

project, the effects of storage, preparation and geographic location of the food on the levels of 

radionuclides will be investigated. The foundation of this project was the study made by 

Norwegian Scientific Committee for Food Safety in 2017, where they concluded that 98% of 

the annual committed effective dose from food was due to natural radioactivity [5]. The 

hypothesis is that this is true for all Nordic countries.   

 

Naturally occurring radionuclides in the environment and in food 

Po210  is one of the final daughters in the chain of the naturally occurring radionuclide 

U238 , decaying with a half-life of 138 d [8]. U238  occurs in soil and minerals, resulting in the 

presence of Po210  deep in the ground [9]. Po210  is also distributed in the atmosphere due to the 

grandparent Rn222  that exist in gas form. From the atmosphere, Po210  is deposited on the 

surfaces and vegetation. The amount of deposition varies due to factors such as rain and 

geographical position. High levels of Po210  are accumulated in marine biota, due to its high 
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complex formation with proteins and uptake in other internal tissues. Po210  is highly radiotoxic 

because of its high energy alpha particle emission and high specific activity.  

One important pathway for Po210  to enter the human body is via ingestion of reindeer 

that has eaten lichen containing the radionuclide [10]. Measurements of Po210  in lichen have 

been carried out in central Sweden since the 1960s. The amount of Po210  fallout has been 

constant since the measurements started. In the future, the deposition may change though due 

to climate changes.  

Diets including a lot of reindeer and caribou has been found to contain large amounts of 

Po210  [10]. A strong dependence of seasons is seen in activity concentration in reindeer meat 

from Lapland, Sweden. In samples from 1969, the activity concentration varied between 3 and 

12 Bq/kg with the highest level in spring. People eating high amounts of reindeer or caribou 

meat is assumed to receive a committed effective dose from Po210  of 260 µSv/y.  

In wild leafy vegetation, the highest contribution to the naturally occurring radioactivity 

is Po210 [10]. In the 1960s, it was found that 80% of the natural radioactivity in plants 

was Po210  originating from deposition of the nuclide and other Rn222  daughters from air, but 

also from absorption of Po210  via the roots. One example of a leafy plant consumed by humans 

is tobacco, in which high levels of Po210  have been found. In the lungs of smokers, the amount 

of Po210  is three times higher than in non-smokers [7].  

Ingestion of Po210  in food is an important contribution to the effective dose to the human 

being. The intake of Po210  from terrestrial food varies between 10 and 100 Bq/y depending on 

differences in geology, climate and agriculture [10]. The largest contribution, 80%, of the 

ingested Po210  is due to fish and shellfish. For example, in Japan and Korea where the diet 

includes high amounts of seafood, the committed effective dose from Po210  is estimated to 270 

µSv/y.  

The average of the committed effective dose from Po210  to the world population is 

assumed to be 70 µSv/y [10]. For vegetarians, the committed effective dose has been estimated 

to 30 µSv/y. For people who eat high amounts of fish, the committed effective dose can be 5-

15 times higher than for vegetarians.  

Other NORM, being important for the effective doses received via ingestion, are K40 , 

U238  and U234 . The physical half-life of K40  is 1.28 ∙ 109 y and some foods are containing 

high amounts of the nuclide, for example bananas (130 Bq/kg), peanuts (215 Bq/kg) and raw 

spinach (240 Bq/kg) [11]. K  is an important element in the human body and the activity 

concentration of K40  is 61 Bq/kg body mass [12]. The uptake of potassium is regulated to hold 

a constant level in the body, therefore any extra intake is excreted [5]. K40  contributes to a 

constant fraction of all potassium and therefore, the committed effective dose received from 

K40  is not affected by the amount of intake of potassium.  

Uranium occurs in all rocks and soils and in natural watercourse [12]. U 238  and U234  

have physical half-lives of 4.47 ∙ 109 y and 2.46 ∙ 105 y, respectively. Uranium is often more 

important as a chemotoxic health risk rather than a radiotoxic. The activity concentration of 
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uranium is on average 12-37 Bq/kg in the earth’s crust and 1.2-12 mBq/kg in water. The 

occurrence of uranium in food is largely variating but some of the highest concentrations, about 

2-3 Bq/kg, of U 238 have been found in root vegetables and leafy vegetables [7]. 

 

Interpolation maps 

The measurement of dose rate or activity concentration in the environment by using a 

detector in a backpack or in a car, result in data at discrete locations. Making an interpolated 

map out of this discrete data gives the advantage of a better overview provided over the 

measured area. This could be useful to quickly find hot spots as well as sorting out safe areas. 

This in turn, enables the measurement to be focused on the hot spots. In this way the 

performance gets more efficient and time saving.1  

Interpolation of dose rate data can also be used to get estimated values at sites where it 

is hard to measure, for example in tough terrains. Additionally, interpolation is good when the 

data are to be presented for authorities and the public since it is easier to understand a continuous 

surface than discrete values.2  

                                                      
1 Mantero Cabrera, Juan; postdoctoral researcher at the department of Radiation Physics at Institute of Clinical 

Sciences, Sahlgrenska Academy, Gothenburg University, 2018, dialogue in November.  
2 Thomas, Rimon; doctoral student at the department of Radiation Physics at Institute of Clinical Sciences, 

Sahlgrenska Academy, Gothenburg University, 2018, dialogue in November. 
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Aim 

The aim of this study was to  

• estimate the committed effective doses received by the Swedish population due to 

naturally occurring radionuclides in the Swedish diet 

• simulate the biokinetics of polonium and investigate the impact of the new 

developments in the biokinetic models on the committed effective dose 

• produce a manual for interpolation of discrete dose rate data in order to create 

continuous dose rate maps.  
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Theory 

Internal dosimetry 

The assessment of doses due to intake of radionuclides into the body is comprised of 

measurements of activities followed by modelling, in order to convert the activity to dose. The 

International Commission on Radiological Protection (ICRP) is providing models required for 

the assessment [13]. Measurement can be done of the activity of the intake, in the body or in 

the excreta. The models then describe the distribution of the radionuclides in the body and the 

energy deposition in the organs. The challenge with internal dosimetry is that the body after the 

intake is exposed to irradiation where the source is varying in geometry and strength. This is a 

result of the heterogeneous distribution in the body due to the biokinetic behaviour of the 

radionuclide, as well as the decrease of activity due to excretion and nuclear decay. The dose 

quantity in internal dosimetry, committed dose, is taking into account that the exposure is not 

momentary by integrating the dose over a period of time.   

Modelling of the biokinetics of a radionuclide entails the uncertainties originating from 

biological differences between individuals [13]. There is incomplete knowledge about the 

processes being modelled and limited ability for calculation of their parameter values. The 

parameters in the ICRP reference models are set as fixed values and are not associated with any 

uncertainties. These parameter values have been extracted from human and animal studies. 

Measurements of the activity concentration result in sources of uncertainties like 

estimation of the sample weight, positioning of the source during measurement and 

contaminations in the sample [13]. 

 

Biokinetic models 
The distribution and retention of a radionuclide in the body depend on factors such as 

type of element, its chemical form and route of intake and is described by biokinetic models 

[13]. The biokinetic models published by ICRP are describing the human body as a 

compartmental system, thus dividing the body in several compartments, containing activity. 

Between the compartments activity can pass back and forth. Each compartment can represent 

an organ, a tissue or a compound of organs. The amount of activity in a compartment is 

described with first order differential equations.  

 

Metabolic models 
To estimate the uptake of radionuclides entering the body via ingestion, the 

gastrointestinal system has to be modelled. ICRP published a gastrointestinal tract model in 

1973 (Figure 1), described in ICRP 30 [14]. The system is described as a compartment model 

including stomach, small intestine and upper- and lower large intestine. This model was 

replaced in 2006 by a new compartment model, Human Allimentary Tract Model (HATM) 

(Figure 2), described in ICRP 100 [15]. The development of the new model took place when 

better understanding of the transfer of materials in the intestines was obtained, as well as better 
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knowledge about the sites where the sensitive cells are located [15]. In HATM, the mouth and 

oesophagus are included as compartments to take into account the possibility of receiving 

radiation doses in these areas as well. In the ICRP 30 model, the uptake of radionuclides to the 

blood was considered to take place from the small intestine. In HATM, absorption of 

radionuclides can occur additionally from the oral cavity, stomach and segments of the colon. 

The transit time, i.e. the time the radionuclide remains in one compartment, is in the old model 

independent of age, gender and the type of material that has been ingested. In the new model 

these things have been considered. The path in HATM starts with entrance of the radionuclide 

into the oral cavity and further on to the oesophagus, stomach, small intestine, colon and at last 

excretion via faeces. Radionuclides can also reach the oesophagus through clearance from the 

respiratory tract. Retention on teeth and in oral mucosa is considered. HATM is a recycling 

model, allowing the radionuclide to go forth and back for example between the walls in the 

stomach and the blood. 

 

 

Figure 1: The old gastrointestinal model described in ICRP 30 [15]. 
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Figure 2: The Human Alimentary Tract Model (HATM) described in ICRP 100 [15]. 

 

When a radionuclide is ingested, an amount of the substance will be absorbed to the 

blood while the rest will maintain in the gastrointestinal tract and later on be excreted. The 

amount absorbed to the blood is in the old GI model referred to as the GI uptake fraction f1 and 

equals the absorbed fraction from the small intestine [15]. In HATM f1 is replaced by the total 

absorbed fraction fA including absorption via other sites in the gastrointestinal tract as well as 

the small intestine. The standard assumption though is that all absorption is taking place in the 

small intestine. Since HATM was developed, ICRP has produced committed effective dose 

coefficients for various elements based on this model, applicable for workers (Publication of 

occupational intakes of radionuclides (OIR)) [16-18].  For the purpose of dose estimation for 

the public, dose coefficients based on HATM are yet not elaborated. The current committed 

effective dose coefficients applicable for the public are based on the old GI model and are 

presented in the ICRP publication 119 [19]. The committed effective dose coefficients, 

expressed in Sv/Bq, are calculated using a specific value of f1 for each element. The GI uptake 

fraction can be affected by the chemical form of the radionuclide ingested. This can be taken 

into consideration by modifying the dose coefficients by scaling [5]. The dose coefficients give 
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the committed effective dose, i.e. the integrated effective dose over a period of time after the 

intake, 50 years for adults and 70 years for children [19]. This can result in a significant 

overestimation of the annual dose [5]. For those radionuclides that have a long retention time 

and thereby deposit energy during several years, the annual dose gets overestimated. For those 

radionuclides that do not maintain in the body more than a year, the committed effective dose 

is corresponding to the annual dose.  

 

Systemic models 
A systemic model describes the distribution of a radionuclide after it has reached the 

blood circulation. The new occupational committed effective dose coefficients presented in the 

publications of OIR [16-18] are based on updates of the systemic models [13]. The development 

of the systemic models includes the possibility of a recycling radionuclide transport between 

compartments, unlike in most of the old models, where transport in one direction was the only 

alternative. Another development in the new systemic models is the modelling of daughter 

nuclides. Instead of following their mothers’ biokinetics as in the old models, they are now 

modelled independently. An update of the committed effective dose coefficients for the member 

of public is planned by ICRP, to include improvements done in the Publications of OIR.   

Some of the organs and tissues in the systemic models are divided in several 

compartments to consider the different transit times and retentions that can occur in the same 

organ or tissue [18]. The function of more than one compartment is also to model the different 

pathways the radionuclide can take when leaving an organ or a tissue.  

 

Polonium 

The systemic model for polonium that was described in ICRP 67 (1993) is assuming that 

the absorbed radioactivity is distributed and accumulated in the liver (30%), kidneys (10%), 

spleen (5%), red bone marrow (10%) and the rest of the body (45%) [20]. The biological half-

life is 50 days. More than 50% of the polonium that reaches the blood, is excreted via faeces. 

In 2001, Leggett and Eckerman (L&E) [21] established a new, more realistic biokinetic model, 

the L&E model (Figure 3). Unlike the model in ICRP 67, the L&E model includes excretion 

via sweat and hair. The L&E model also includes a compartment for the bone surface as well 

as a more proper modelling of the excretion in urine [22]. In the Publications of OIR, the L&E 

model is implemented [18].  
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Figure 3: The systemic model for polonium (L&E model) [5]. HRTM: Human Respiratory Tract Model, RBC: Red Blood 

Cells. The Plasma is modelled as three compartments, Plasma 1, 2 and 3.  

 

When polonium has reached the blood, first a fast decrease in amount is taking place 

followed by a slower reduction [18]. The liver is receiving a large amount, 35% of the systemic 

polonium, while 10% is deposited in the kidneys and 2% in the spleen. The skin is receiving 

5% of the polonium and half of it is excreted via hair and sweat, while the other half is returned 

to the blood. The red marrow is receiving 4% and the bone surface 1.5%. The bone surface has 

the longest retention half-life of the tissues in the body. Other tissues are absorbing 32.4%.  

The GI uptake fraction has been studied in several research projects and different values 

have been estimated: 0.56 ±  0.04 (2001), 0.51 (2007) and 0.46 ±  0.08 (2012) [23]. The 

biological half-life has also been estimated in different studies: 38 ± 1 d (2001), 42 ± 1 d 

(2007) and 31 ± 5.5 d (2012) [23].  

 

Uncertainties and limitations in biokinetic models 
Uncertainties associated with a biokinetic model can be caused by a model structure that 

is simplifying the processes too much [24]. Parts in a process that are unknown and thereby not 

included in the model result in uncertainties. The extent of uncertainties involved in a biokinetic 

model is variating for different radionuclides, because of the differences in biokinetic 

knowledge. 

In HATM, uncertainties are associated with the radionuclide absorption, the transit times 

and the anatomical construction [15].  

The biokinetics in the human body depends on, for example, the diet and the age of the 

person. The biokinetics also variates between different humans. There are two types of 
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variability, defined in ICRP 100, inter-individual variability and intra-individual variability 

[15]. Inter-individual variability is the differences between persons under similar conditions 

and intra-individual variability is the differences in one person under different conditions.   

 

Integrated Modules for Bioassay Analysis (IMBA) 

Integrated Modules for Bioassay Analysis (IMBA) is a set of software components for 

estimation of internal doses by using the ICRP biokinetic models [25]. Each software 

component has a specific function, for example calculating organ doses or approximating the 

intake of a radionuclide. One component is representing the biokinetic models. The retention 

Rs(t)  in all source organs is described with the same equation, irrespectively of the 

radionuclide:  

𝑅𝑠(𝑡) = ∑ 𝑎𝑖𝑒
−𝜆𝑖𝑡𝑛

𝑖=1                                                         (1)                                                  

 

where ai  is a dimensionless amplitude, λi  [ d−1 ] is the transfer rate, n  is the number of 

exponential terms and t [d] is the time after the entrance of the radionuclide into the organ. At 

t = 0, Rs(t) = 0 for all organs and tissues besides the blood that has the retention Rs(t) = 1.  

 

Models implemented in IMBA 

The models implemented in IMBA are the old gastrointestinal model from ICRP 30 

(1979), the non-recycling systemic models from ICRP 30 (1979) and the recycling systemic 

models from ICRP 56 (1989) [25]. The radiation and tissue weighting factors used in IMBA 

are those published in ICRP 60 (1991) and ICRP 68 (1994), respectively.   

 

Simulation, Analysis and Modelling Software II (SAAM II) 

Simulation, Analysis and Modelling Software II (SAAM II) is a software for 

compartmental modelling [26]. SAAM II produces a system of first order differential equations 

from the user defined compartmental model including specific parameters and input values. 

The output of the model is determined by the software and can be presented to the user in a 

graphical form.  

 

Ecolego 

Ecolego is a software for simulation of models, specialized on estimation of radiological 

risk [27]. Advantages with Ecolego compared with SAAM II is the built-in function for 

considering of the physical decay, as well as the greater possibilities of solving the differential 

equations of the model. Ecolego can solve stiff problems, i.e. models with largely varying 
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transfer coefficients. Ecolego also has a build-in function for integration of the amount in the 

simulated model.  

 

The Kriging interpolation method 

Kriging is a geostatistical method, which means interpolation considering the statistical 

relationship between the data points [28]. This results in an interpolation with an estimated 

uncertainty. Kriging is a good method to use for interpolation of data points that are correlated 

spatially and is used for example in soil science and geology. The Kriging formula is described 

as 

Ẑ(𝑠0) = ∑ 𝜑𝑖𝑍(𝑠𝑖)
𝑁
𝑖=1 ,                                                         (2) 

 

where Ẑ(s0) is the prediction at location s0, 𝜑𝑖 is a weighting factor for measured value i, Z(si) 

is the measured value at location si and N is the number of measured values. The weighting 

factor 𝜑𝑖 depends on a model fitted to the measured points, the distance to the location of the 

prediction and the spatial relationship between the measured points.   

The first step in Kriging is to investigate the spatial relationship between the data points, 

by making a semivariogram [28]. For all points i and j separated with distance h, the 

semivariance S(h) is calculated as  

 𝑆(ℎ) =
1

2
 ∙ 𝑎𝑣𝑒𝑟𝑎𝑔𝑒((𝑣𝑖 − 𝑣𝑗)2),                                             (3) 

 

where vi and vj are the values at locations i and j, respectively. The semivariogram is created by 

plotting the semivariance S as a function of the distance h. The semivariogram is then fitted to 

a model, where a spherical model is the most used.  

The second step is to calculate the weights 𝜑𝑖  using the information from the fitted 

semivariogram [28]. The values nearest the position of the prediction has the highest influence 

and the prediction is then made using the Kriging formula.    

In ArcGIS 10.6, there are two types of geostatistical methods using the Kriging formula, 

named Kriging/CoKriging and Empirical Bayesian Kriging (EBK) [28]. There are two main 

differences between the two methods. In EBK, the Kriging parameters are calculated 

automatically while in Kriging/CoKriging, you have to select them yourself. EBK gives a better 

estimate of the errors of the prediction compared with Kriging/CoKriging. This is because the 

errors in the semivariogram is accounted for in EBK and not in Kriging/CoKriging. The 

disadvantage with EBK is that the calculation takes longer time than in Kriging/CoKriging.  

The Kriging method has been used when making interpolation of the levels of Cs137  in 

the environment in Sweden [29].  



14 

Method 

Activity concentration  

The activity concentration of Po210 , U238  and U234  in various food and foodstuffs were 

obtained from the research projects Radiological implications of Swedish food consumption and 

NANOD - Natural Radioactivity in the Nordic Diet. Washing and removal of the parts of the 

food that are not edible was performed of the samples. The activity concentration was measured 

using alpha spectrometry.  

Activity concentration of Po210 in diet containing animal protein and lacto-ovo 

vegetarian diet was collected from the research project Radiological implications of Swedish 

food consumption. Lunch and dinner samples for both diets were collected from a restaurant at 

Sahlgrenska University Hospital. The difference in committed effective dose estimated from 

the different diets was investigated.  

 

Food consumption 

The food consumption of the Swedish population was collected from the Swedish Board 

of Agriculture (Jordbruksverket), the Swedish National Food Agency (Livsmedelsverket) and 

the report Svensk konsumtion av sjömat – en växande mångfald from Research Institutes of 

Sweden [30]. Food consumption data for adults were found in the report Food consumption 

and nutritive values, data up to 2016, from the Swedish Board of Agriculture [31]. The data 

used are averages of the consumption during the years 2014, 2015 and 2016. In that report, the 

consumption data for fish were incomplete but were found in the report Svensk konsumtion av 

sjömat – en växande mångfald [30]. The food consumption data for children were extracted 

from Food consumption and nutritive values, data up to 2016 [31] and Svensk konsumtion av 

sjömat – en växande mångfald [30] in combination with the Swedish National Food Agency 

reports Livsmedels- och näringsintag bland barn i Sverige [32] and Livsmedelskonsumtion 

bland ungdomar i Sverige [33]. The consumption data for children used in the calculation were 

fractions of the consumptions of adults. This was done because the consumption data for 

children were for food groups. For example, the proportion of the consumption of all vegetables 

could be applied to the consumption data for different vegetables available for adults.  

A comparison of the committed effective dose for adults was done using different food 

consumption data. Consumption data were extracted from the United Nations Scientific 

Committee of the Effects of Atomic Radiation (UNSCEAR) 2008 report [3] and the Swedish 

National Food Agency report Livsmedels- och näringsintag bland vuxna i Sverige [34]. 

The difference in committed effective doses received by Swedish women and men due 

to different food consumption habits was investigated. The consumption data for women and 

men were collected from the report Livsmedels- och näringsintag bland vuxna i Sverige [34].  

The food consumption data used in the calculations are presented in Appendix A: Food 

consumption data. 
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Dose estimation using dose coefficients 

The committed effective doses from Po210 , U238  and U234  were calculated using the 

dose coefficient for respective radionuclide extracted from ICRP 119 [19]. The committed 

effective dose E [Sv/y] was calculated as   

 

𝐸 = ∑ 𝑎𝑖𝑖 𝑐 𝑒𝑖,                                                                               (4) 

 

where ai  is the activity concentration for radionuclide i [Bq/kg], c is the food consumption 

[kg/y] and ei is the committed effective dose coefficient for radionuclide i [Sv/Bq].  
 

Dose simulation by IMBA 

Simulation of the dose from Po210  was performed by varying the GI uptake fraction, the 

transfer rate between stomach and small intestine and the tissue weighting factors. The GI 

uptake fraction values used in the simulation are shown in Table 2 and are extracted from the 

study of biokinetics of polonium in man by Henricsson et al. [23].  

 

Table 2: GI uptake fraction for polonium [23]. 

 

    

 

 

Transfer rates in HATM were used to variate the transport between stomach and small 

intestine. The transfer rate for women and men were used to examine the sex dependence in 

dose. The transfer rates are shown in Table 3 and are collected from ICRP 100 [15].  

 

Table 3: Transfer rate between stomach and small intestine [15]. 

Type of content in the GI tract Transfer rate for women, [𝑑−1] Transfer rate for men, [𝑑−1] 

Solids 13.71 19.2 

Caloric liquids 24 32 

Non-caloric liquids 48 48 

Total diet 15.16 20.54 

 

Tissue weighting factors were found in ICRP 133 (2016) and were used in the simulation 

to compare with the weighting factors implemented in IMBA, originating from ICRP 68 (1994). 

The weighting factors from ICRP 68 are the ones used in the calculation of the present 

GI uptake fraction, 𝑓1 

0.46 

0.51 

0.56 
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committed effective dose coefficients for the public [19]. The weighting factors from ICRP 68 

are shown in Table 4 [36] and factors from ICRP 133 are shown in Table 5 [35].   

 

Table 4: Tissue weighting factors from ICRP 68 (1994) [36]. 

Tissue 𝑤𝑇 

Gonads 0.20 

Red marrow, colon, lung, stomach 0.12 

Bladder, breast, liver, oesophagus, thyroid, remainder* 0.05 

Skin, bone surface 0.01 

*Remainder: adrenals, brain, small intestine, kidney, muscle, pancreas, spleen, thymus, uterus.  

 

Table 5: Tissue weighting factors from ICRP 133 (2016) [35]. 

Tissue 𝑤𝑇 

Active bone marrow, breast, colon, lung, stomach, remainder tissues* 0.12 

Gonads 0.08 

Urinary bladder, oesophagus, liver, thyroid 0.04 

Bone endosteum, brain, salivary glands, skin 0.01 

*Remainder tissues includes adrenals, extrathoracic regions of the respiratory tract, gall bladder, heart, kidneys, 

lymphatic nodes, muscle, oral mucosa, pancreas, prostate, small intestine, spleen, thymus, uterus/cervix.  

 

Simulation of biokinetic models in SAAM II and Ecolego 

To investigate the impact of the committed effective dose due to new developments in 

the biokinetic models, the distribution and retention of polonium in the human body was 

simulated by building HATM and the systemic model in SAAM II. To give a more accurate 

dose assessment for the Swedish population, the committed effective dose coefficient for Po210  

was calculated and used in the dose estimation.  

The transfer coefficients needed were collected from ICRP 100 [15] for HATM and 

from ICRP 137 [18] for the systemic model for polonium. The simulated intake was 1 Bq 

Po210  and was given in the compartment for oral cavity in HATM. To simulate both fast and 

slow motion of the swallowed activity, oral cavity was divided into two compartments. The 

transport of an ingested material is characterised by fast motion to 90% and by slow motion to 

10% [15]. Therefore, 0.9 Bq Po210  was given to the compartment for fast motion and 0.1 Bq 

Po210  was given to the compartment for slow motion. The two compartments for the oral cavity 

are connected to one compartment for oesophagus each (fast and slow) and then they both 

connect to one compartment for the stomach. The two models were connected by letting the 

activity in small intestine in HATM flowing to plasma 1 in the systemic model. Reabsorption 

from blood to the gastrointestinal tract was simulated by an activity flux between liver 1 and 

small intestine.  
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The transfer rate λSI,B from small intestine to blood was calculated as 

 

𝜆𝑆𝐼,𝐵 =
𝑓𝑆𝐼𝜆𝑆𝐼,𝑅𝐶

1−𝑓𝑆𝐼
 ,                                                              (5) 

 

where fSI = 0.5 is the absorbed fraction from small intestine to blood and λSI,RC is the transfer 

rate between small intestine and right colon [15]. λSI,B was calculated to 6 d−1. To include the 

physical decay of Po210 , every compartment was added an outflow equalling the decay constant 

of the radionuclide, i.e. λ Po210 = 0.0072 d−1 [37]. The model and the transfer coefficients used 

are shown in Appendix B: The model used in SAAM II and Ecolego. 

The software GraphPad Prism was used to fit the retention data to a sum of exponential 

curves. The retention curves were integrated, using the integration limit 50 years to get the time 

integrated activity. Using the methodology in ICRP 133 [35], the committed effective dose 

coefficient for Po210 , applicable for the public, was calculated. The coefficient applicable for 

workers was calculated by using fSI = 0.1 and was compared with the coefficient calculated by 

ICRP [18]. This comparison was done to verify the calculations.  

Po210  decays to the stable nuclide Pb206  through alpha particle emission. The energy of 

the alpha particle is 5.30 MeV and the yield is 1 [8]. The radiation weighted S coefficient 

Sw(rT ← rS) was calculated for female and male, respectively, as 

 

𝑆𝑤(𝑟𝑇 ← 𝑟𝑆) = 𝑤𝛼𝐸𝛼𝑌𝛼𝛷(𝑟𝑇 ← 𝑟𝑆) ,                                                              (6) 

 

where rT  and rS  are the target and source region, respectively, wα = 20  is the radiation 

weighting factor for alpha particles, Eα is the energy of the alpha particle, Yα is the yield of the 

decay and Φ(rT ← rS)  is the specific absorbed fraction [35]. For the compartment other 

including several source regions rS, 𝛷(𝑟𝑇 ← 𝑟𝑆) was calculated as  

 

𝛷(𝑟𝑇 ← 𝑜𝑡ℎ𝑒𝑟) =
1

𝑀𝑜𝑡ℎ𝑒𝑟
∑ 𝑀𝑟𝑆

𝛷(𝑟𝑇 ← 𝑟𝑆)𝑟𝑆
,                                                   (7) 

 

where Mother is the total mass of the source regions included in the compartment other and 𝑀𝑟𝑆
 

is the mass of source region rS. The S coefficients are presented in Appendix C: S coefficients 

for 𝐏𝐨𝟐𝟏𝟎 . The committed equivalent dose coefficient h(rT) in target region rT was calculated 

for female and male as 

 

ℎ𝐹(𝑟𝑇) = ∑ ã(𝑟𝑆)𝑟𝑆
𝑆𝑤

𝐹 (𝑟𝑇 ← 𝑟𝑆),                                                            (8) 
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ℎ𝑀(𝑟𝑇) = ∑ ã(𝑟𝑆)𝑟𝑆
𝑆𝑤

𝑀(𝑟𝑇 ← 𝑟𝑆) ,                                           (9) 

 

where ã(rS) is the integrated activity and Sw
F (rT ← rS) and Sw

M(rT ← rS) are the S coefficients 

for female and male, respectively. The target regions extrathoracic region, lung, colon and 

lymphatic nodes consist of several target tissues and for each target tissue, a fractional 

weighting factor is needed to be added to the equivalent dose coefficient. The committed 

effective dose coefficient e was calculated as 

 

𝑒 =  ∑ 𝑤𝑇 (
ℎ𝑇

𝐹+ℎ𝑇
𝑀

2
)𝑇  ,                                                        (10) 

 

where wT is the weighting factor for tissue T.  

To verify the results from SAAM II, the software Ecolego was used to perform the 

biokinetic simulation.3 

 

Interpolation maps 

The software ArcGIS 10.6 was used to produce interpolation maps from discrete dose 

rate data. The method Empirical Bayesian Kriging (EBK) was used. A manual for the procedure 

of making the interpolation map was produced and tested using dose rate data over an area in 

Kvarntorp, Kumla municipality in Sweden, called Kvarntorpshögen. Interpolated dose rate 

maps were produced using 30% and 50% of the data, respectively. To examine the accuracy of 

the interpolation method, interpolated values were then compared with measured values in 

respective coordinate. 

 

                                                      
3 The simulation in Ecolego was carried out by Mats Isaksson; professor at the Department of Radiation Physics, 

Institute of Clinical Sciences, Sahlgrenska Academy, Gothenburg University.  
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Results 

Dose estimation using dose coefficients 

The calculated committed effective doses from Po210 ,  U238 ,  U234  and the sum of those 

three radionuclides are shown in Table 6-Table 8. The committed effective dose from Po210  in 

different diets are shown in Table 9. 

 

Table 6: Committed effective doses calculated using the dose coefficients from ICRP 119 [19] and food consumption data from 

the Swedish Board of Agriculture [31], the Swedish National Food Agency [32, 33] and the report Svensk konsumtion av 

sjömat – en växande mångfald [30]. The given uncertainties are calculated using 95% confidence interval. For adults the 

uncertainties include uncertainties in activity concentration and for children the uncertainties include uncertainties in activity 

concentration and food consumption.  

Age group Committed effective dose [µSv/y] 

Po210  U238  U234
 Sum 

Children  

4-5 years 

120 ± 10 0.33 ± 0.08   0.39 ± 0.08 120 ± 10 

Children  

10-12 years 

86 ± 9 0.33 ± 0.09 0.37 ± 0.04 87 ± 9 

Children  

15 years 

75 ± 7 0.34 ± 0.08 0.39 ± 0.08 76 ± 7 

Children, 

average 

94 ± 9 0.33 ± 0.08 0.38 ± 0.07 94 ± 9 

Adults 76 ± 2 0.38 ± 0.04 0.45 ± 0.03 77 ± 2 

 

 

Table 7: Committed effective doses for adults calculated using the dose coefficients from ICRP 119 [19] and different 

consumption data [3, 30, 31, 34]. The given uncertainties are calculated using 95% confidence interval. The uncertainties in 

the three comparing effective doses include uncertainties in activity concentration. The uncertainty of the effective dose 

calculated using consumption data from the Swedish National Food Agency also includes uncertainties in food consumption.  

Origin of food consumption data Committed effective dose [µSv/y] 

Po210
 U238

 U234
 Sum 

The Swedish Board of Agriculture and Svensk 

konsumtion av sjömat – en växande mångfald 
76 ± 2 0.38 ± 0.04 0.45 ± 0.03 77 ± 2 

The Swedish National Food Agency 150 ± 20 

 

0.34 ± 0.09 0.50 ± 0.07 150 ± 20 

UNSCEAR 2008 160 ± 7 0.41 ± 0.05 0.47 ± 0.03  160 ± 7 
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Table 8: Committed effective doses for Swedish women and men calculated using the dose coefficients from ICRP 119 [19] 

and the consumption data from the Swedish National Food Agency report Livsmedels- och näringsintag bland vuxna i Sverige 

[34]. The given uncertainties are calculated using 95% confidence interval. The given uncertainties include uncertainties in 

activity concentration and food consumption.  

 

Sex 

Committed effective dose [µSv/y] 

Po210  U238  U234
 Sum 

Female 140 ± 20 0.29 ± 0.08   0.40 ± 0.06 140 ± 20 

Male 160 ± 20 0.41 ± 0.10 0.58 ± 0.09 170 ± 20 

 

 

Table 9: Committed effective doses from 𝑃𝑜210  for diet containing animal protein and lacto-ovo vegetarian diet, calculated 

using the dose coefficients from ICRP 119 [19]. The ranges of committed effective dose from lunch and dinner and the sum of 

the meals are shown for the diets. The given uncertainties are calculated using 95% confidence interval. The given uncertainties 

include uncertainties in activity concentration. 

 

Diet 

Committed effective dose from Po210  [µSv/y] 

Range of lunch and dinner Sum 

Diet containing animal protein [18 ± 0.8; 37 ± 3 ]  58 ± 3  

Lacto-ovo vegetarian diet [6.3 ± 0.4; 6.9 ± 0.3 ]  13 ± 1 

 

 

Dose simulation by IMBA 

The committed effective doses received from Po210
 simulated by IMBA using different 

GI uptake fractions are shown in Figure 4. The committed effective dose tends to increase 

linearly with the GI uptake fraction.  

 

 

Figure 4: Committed effective dose received from 𝑃𝑜210  as a function of GI uptake fraction. 
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The simulated committed effective doses from Po210
 using different tissue weighting 

factors are shown in Table 10.  

 

Table 10: The committed effective dose received from 𝑃𝑜210  using different tissue weighting factors. 

Origin of tissue weighting factors Committed effective dose [µSv/y] 

ICRP 68 (1994) 56 

ICRP 133 (2016) 69 

 

By varying the transfer rate between stomach and small intestine, women are estimated 

to receive a slightly higher committed equivalent dose from Po210  to stomach than men, see 

Table 11. When using the ICRP 68 weighting factors, the equivalent stomach dose in women 

was about 0.3% higher. This difference could be seen after minimum 2 years and for all types 

of food. When using the ICRP 133 weighting factors, the equivalent stomach dose in women 

was about 0.2% higher than in men and this difference could not be seen until after 16 years. 

Similar results were found for solid and caloric liquid food. For total diet, women were 

estimated to receive 0.3% higher equivalent dose to stomach after 15 years, using the ICRP 133 

weighting factors.  

 

Table 11: The difference in equivalent stomach dose to women compared with men, using different tissue weighting factors. 

The data correspond to the higher equivalent stomach dose in percentage received to women compared with men. The time 

after the exposure when the difference was noticeable are shown in brackets. 

Tissue weighting 

factors 

The difference in equivalent stomach dose estimated to women 

compared with men 

Solid food Caloric food Total diet 

ICRP 68 (1994) 0.3% (2 y) 0.3% (2 y) 0.3% (2 y) 

ICRP 133 (2016) 0.2% (16 y) 0.2% (16 y) 0.3% (15 y) 
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Simulation of biokinetic models in SAAM II and Ecolego 

The calculated committed effective dose coefficients for Po210  are shown in Table 12. 

 

Table 12: Committed effective dose coefficients from 𝑃𝑜210  (𝑆𝑣/𝐵𝑞) applicable for the public and for workers, calculated 

from simulations in SAAM II and Ecolego. For comparison, the committed effective dose coefficient for workers from ICRP 

137 [18] and the coefficient for the public from ICRP 119 [19] are shown.  

 

When comparing the results of the committed effective dose coefficient for workers 

from ICRP 137, the simulation data from SAAM II gave a 6% higher value and the data from 

Ecolego gave a 7% higher value. When comparing the results of the coefficient for the public 

from ICRP 119, the simulation data from SAAM II gave a 18% higher value and the data from 

Ecolego gave a 6% higher value.  

The committed effective dose received to the Swedish adults, estimated using the 

calculated dose coefficients are shown in Table 13. The consumption data used in this 

calculation are extracted from the Swedish Board of Agriculture [31] and from Svensk 

konsumtion av sjömaten - en växande mångfald [30].  

 

 
Table 13: Committed effective dose (µ𝑆𝑣) to Swedish adults from NORM in food, estimated using the calculated dose 

coefficients from the simulations in SAAM II and Ecolego. The consumption data used are extracted from the Swedish Board 

of Agriculture [31] and from Svensk konsumtion av sjömaten - en växande mångfald [30]. The effective doses from 𝑈238  and 

𝑈234  were calculated using the dose coefficients from ICRP 119 [19]. 

 

 

 

 

 

 

 

         Origin of simulation  

                      data 

  Application 

Committed effective dose coefficient 

 

SAAM II 

 

Ecolego 

 

ICRP 137 

(2017) 

 

ICRP 119 

(2012) 

for the public 1.42 ∙ 10−6  1.27 ∙ 10−6  - 1.20 ∙ 10−6 

for workers 1.91 ∙ 10−7  1.93 ∙ 10−7  1.80 ∙ 10−7  - 

                                  Origin of simulation data 

 

Committed effective dose ( µ𝑆𝑣) 

SAAM II Ecolego 

from Po210  90 ± 2 81 ± 2 

total (considering U238  and U234  as well) 91 ± 2 81 ± 2 
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Interpolation maps  

The interpolated dose rate map is shown in Figure 5. The produced manual for 

interpolation using the Empirical Bayesian Kriging method is shown in Appendix D: ArcGIS 

manual for interpolation using the Empirical Bayesian Kriging method.  

 

 

Figure 5: Discrete dose rate data are shown to the left and the interpolation map based on that data set is shown to the right. 

 

The distribution of the discrete data used for the interpolation maps are shown in Figure 

6. Predicted values from the interpolated maps based on 30% and 50% of the data are compared 

with measured values in Figure 7 and Figure 8. The predicted values from the interpolated map 

based on 30% of the data were in general highly overestimated. The most protruding predicted 

value is 2.4 times larger than the measured. Pearson coefficient was r = -0.0026 and R2 = 7 ∙

10−6. From the map based on 50% of the data, the predicted values largely agreed with the 

measured values, with a few outliers. The most protruding value differs by 26% from the 

measured value. Pearson coefficient was r = 0.96 and R2 = 0.92.  
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Figure 6: Distribution of the discrete dose rate data and appurtenant interpolation map. On top is shown 30% of the data, in 

the middle 50% of the data and at the bottom 100% of the data.  

 

 

Figure 7: Predicted values from the interpolated dose rate map based on 30% of the data, plotted as a function of measured 

values. 
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Figure 8: Predicted values from the interpolated dose rate map based on 50% of the data, plotted as a function of measured 

values. 
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Discussion 

Dose estimation using dose coefficients 

In this study, the received committed effective dose to the Swedish population from 

naturally occurring radionuclides in food and foodstuffs, was calculated. Using different food 

consumption data, the committed effective doses to adults were [76 ± 2; 160 ± 7] µSv/y for 

Po210 , [0.34 ± 0.05 ; 0.41 ± 0.05]  µSv/y  for U238 , [0.45 ± 0.03 ; 0.48 ± 0.03]  µSv/y  for 

U234 . The total committed effective dose to the Swedish adults was [77 ± 2; 160 ± 7] µSv/y.  

The data consisting of a combination of the consumption data from The Swedish Board 

of Agriculture and Svensk konsumtion av sjömat – en växande mångfald, were the most detailed 

data that were used. The data were produced by correcting the food production in Sweden with 

foreign trade and waste due to processing of raw materials. Information was given for 

consumption of different types of vegetable, fruit, meat, fish etc., while the other two 

consumption data sets that were used gave information on consumptions of food groups. One 

disadvantage with this data set is that the fish consumption data were presented as total 

consumption of the whole Swedish population. To get the consumption per capita, the data were 

divided by the population in Sweden in 2015. The population data were collected from the 

authority of statistics, SCB, and to consider that children eat less than adults and that the 

youngest children do not eat fish, the population under 15 years was not included. The data 

from the Swedish National Food Agency report Livsmedels- och näringsintag bland vuxna i 

Sverige have been collected by surveys where participants were filling in every food intake. 

This type of data collection results in the possibility of errors due to bad estimation of food 

consumption by the participant. Another disadvantage with this data set is that dishes are 

registered as the main ingredient of the dish, for example a meat pot is registered as meat. This 

means that other ingredients in the meat pot are not registered. In the UNSCEAR 2008 report, 

the mean food consumption for the world population is presented, giving the obvious 

disadvantage that these consumption data do not represent the Swedish population. The 

consumption data consisting of a combination of data from The Swedish Board of Agriculture 

and Svensk konsumtion av sjömat – en växande mångfald, were considered to be the most 

accurate. Therefore, the dose estimation out of this consumption data set was considered to be 

the best. One limitation of this data set is that no uncertainties are given, because this was 

considered to be too hard to estimate. This causes a misleading uncertainty in the dose, being 

too small when considering only the uncertainties in the measurement and sample preparation. 

The uncertainties in the doses were higher for children than those for adults, except for the 

doses calculated using data from the Swedish National Food Agency. This is because the 

consumption data from the Swedish National Food Agency were given with uncertainties which 

was propagated into the uncertainty in the dose.  

The committed effective dose to the Swedish adults from NORM in food has been 

estimated by Statens strålskyddsinstitut (SSI) (the predecessor of the Swedish Radiation Safety 

Authority, SSM) to 200 µSv/y [4]. This estimation is based on global reference values for 

activity concentrations in food in combination with a world average food consumption. From 
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the results in the present study, the estimated committed effective dose to the Swedish adults 

was smaller, 77 ± 2 µSv/y, when using activity concentration representing Swedish food and 

consumption data representative for Swedes. 

When comparing the committed effective doses to the world population, presented in 

UNSCEAR 2000 [7], with the committed effective doses to the Swedish population calculated 

in this study, the doses received from Po210  to adults are very similar, 76 ± 2 µSv/y  to the 

Swedish adults vs. 70 µSv/y to the world population. The average of the committed effective 

doses from Po210  to Swedish children is 94 ± 9 µSv/y compared with the world average of 

100 µSv/y. The committed effective doses received from U238  and U234  were larger for the 

Swedish population than for the world population, as can be seen in Table 1.   

Comparing the doses calculated in the Norwegian study [5] to the doses estimated in this 

study it can be seen that the adult Norwegian people are receiving a committed effective dose 

from Po210  of 120 µSv/y compared with 76 ± 2 µSv/y calculated in this study.  

When comparing lacto-ovo vegetarian and animal protein containing diet, the dose 

difference is large. Swedish people who eat a diet including animal protein receive an almost 

4.5 times greater committed effective dose from Po210  than those who eat a lacto-ovo 

vegetarian diet. The reason for this is that the levels of Po210  in general is much higher in meat 

and fish than in vegetable food. These results were based on meals collected from a restaurant. 

These food samples consisted of cooked food and foodstuff, in comparison with the other 

samples that were raw. The committed effective dose estimated from the cooked meals were 

much smaller than the doses estimated from raw samples. This could be a result of the cooking 

effect. The cooking effect is the impact in amount of a radionuclide due to heating of the food. 

It has been shown that the concentration of Po210  in different foods, both can increase and 

decrease due to cooking [38]. A decrease can occur as a result of  Po210  evaporating due to its 

volatility and an increase can occur if there is loss of water which in turn leads to a higher 

concentration [38]. In the present study, it seems that the overall cooking effect decreased the 

amount of Po210 . The amount of Po210  is also affected by storage of the food before cooking. 

If using frozen food, the amount of the radionuclide can be lower compared with fresh food, 

due to physical decay (half-life of 138 d). Another factor contributing to the lower committed 

effective dose estimated from the cooked food, is that the food consumption per day was 

considered to consist of lunch and dinner, since there were the only such samples collected. The 

estimated committed effective doses should be somewhat higher if other meals during the day 

were included. 

The difference between female and male showed that a 20% larger dose was received 

by Swedish men. The natural cause of this is that men eat more because of the larger energy 

need, but also because of differences in food habits. The consumption data show that Swedish 

men eat 60% more meat, 10% less vegetables and 40% less fruits than Swedish women. For 

fish, which gives the highest contribution of the committed effective dose, men have a 16% 

higher consumption than women.  
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Dose simulation by IMBA 

The GI uptake fraction values for Po210  extracted from the study of biokinetics of 

polonium in man by Henricsson et al. [23] result in estimated committed effective doses in the 

range [51.3; 62.5] µSv/y to Swedish adults. This gives a difference in committed effective dose 

of ± 9% compared with the corresponding value, using the GI uptake fraction defined by ICRP. 

In the study by Henricsson et al., the GI uptake fraction is estimated to 0.46 and the other two 

GI uptake fractions from the study, are collected from earlier studies (Thomas et al, 2001 and 

Hunt and Rumney, 2007). The GI uptake fraction is by ICRP considered to be 0.5 since 1993 

when it was changed from 0.1 [23]. When taking the GI uptake fraction to be 0.5, the dose is 

55.8 µSv/y, using IMBA. As the GI uptake fraction has been estimated to values both higher 

and lower than the one stated by ICRP, indicates that 0.5 may be a proper estimation. One 

difficulty in estimating the GI uptake fraction for polonium is the occurrence of Po210  in the 

body due to intake of the nuclide every day via ingestion. This background level must be 

considered when studying the kinetics of Po210 , which was the cases in the studies by Thomas 

et al and Hunt and Rumney [23]. In these two studies, volunteers were eating caribou and crab 

meat, respectively. Henricsson et al. examined the kinetics of Po209  in the body by letting 

volunteers ingest a known amount of the nuclide. When using a nuclide that is not naturally 

present in the body, there was no background level disturbing the measured radioactivity.  

The biological half-life was estimated in the studies by Henricsson et al. (31 ± 5.5 d), 

Leggett and Eckerman (38 ± 1 d), and Hunt and Rumney (42 ± 1 d) and they all got values 

lower than the half-life stated by ICRP (50 d) [23]. In IMBA, there is no possibility to change 

the biological half-life. Therefore, no estimation was done of the impact this could have on the 

committed effective dose to the Swedish population.  

When using different tissue weighting factors in the simulation in IMBA, the results 

showed that the new weighting factors from ICRP 133 result in a higher estimate of the 

committed effective dose from Po210 , 69 µSv/y, compared with 56 µSv/y when using the 

factors from ICRP 68. This is an increase of 23% and shows the importance of an update of the 

committed effective dose coefficient for Po210 , using the tissue weighting factors from ICRP 

133 instead of ICRP 68.  

By varying the transfer rates between stomach and small intestine and studying the sex 

dependence in committed effective dose, very small differences were found, and women 

received a higher committed equivalent stomach dose than men.  

 

Simulation of biokinetic models in SAAM II and Ecolego 

The calculated committed effective dose coefficient for workers were 6-7% higher than 

that in ICRP 137 [18]. The greatest challenge in the calculation of the coefficient, using the 

simulations from SAAM II, was to get an accurate integration of the activity in the 

compartments. The curve fitting software GraphPad Prism was not able to find good fits for 

some of the compartments. For example, for women and fSI = 0.1, GraphPad Prism was not 
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able to determine the parameters in the best fitted curve for the compartments kidney 2, spleen, 

red marrow, plasma 3 and gonads. For most of the compartments, R2 was 0.99 but for skin R2 

was 0.94, for plasma 1 R2 was 0.78 and for bone surface R2 was 0.95. Similar problems were 

present for men and when using fSI = 0.5. Ecolego, on the other hand, has a built-in function 

for integrating the activity in the compartments and therefore curve fitting is not included in the 

calculation [27].  

Another advantage with Ecolego compared with SAAM II is the greater opportunities 

of solving the differential equations of the simulated model. Ecolego uses models that can solve 

stiff problems, i.e. models with largely variating transfer factors [27]. Since this is the case in 

this study, the results from Ecolego can be suggested to be more accurate than those from 

SAAM II. The different methods of solving the differential equations in SAAM II and Ecolego 

can be the reason for the difference in the calculated committed effective dose coefficients for 

the public. The coefficient calculated using the simulation data from SAAM II was 18% higher 

than the old coefficient from ICRP 119 [19] and when using the simulation data from Ecolego, 

the coefficient was 6% higher. When comparing the integrated activities for each compartment, 

there were large differences between the results from SAAM II and Ecolego. In 64% of the 

source organs (blood, red marrow, kidney, liver, spleen, urinary bladder contents and other) 

Ecolego gives a 13-18% higher integrated activity, compared with SAAM II. For the rest of the 

source organs, Ecolego gives lower values: 18-21% lower for bone surface and 27-33% lower 

for skin and gonads. This displays the difficulty of the integration.  

The estimated committed effective dose received by the Swedish adults was 91 ± 2 

µSv/y using the coefficient calculated from the data from SAAM II and 81 ± 2 µSv/y using 

the coefficient calculated from the data from Ecolego. The consumption data used in this 

estimation are extracted from the Swedish Board of Agriculture [31] and from Svensk 

konsumtion av sjömaten - en växande mångfald [30]. When using the old committed effective 

dose coefficient from ICRP 119 [19], the estimated dose is 77 ± 2 µSv/y. The results of this 

study suggest that the new development in the biokinetic models for polonium is leading to a 

5-18% higher committed effective dose to Swedish adults from NORM in food.  

 

Interpolation maps 

The interpolated dose rate maps were obtained from ArcGIS 10.6. The interpolation was 

carried out using the Empirical Bayesian Kriging method, since the Kriging method has been 

used in an earlier study when interpolating the levels of Cs137  in the environment in Sweden.  

When comparing the measured values with the predicted received from the interpolation 

using 30% of the data, it could be seen that the estimation was largely overestimated for most 

of the values. That data set (see Figure 6) is distributed as a line in a form of an ellipse, compared 

with the 50% and 100% data sets which include values distributed within that ellipse. This is 

probably the reason for the bad agreement between the predicted and the measured values. 

Pearson coefficient was r = -0.0026 and R2 = 7 ∙ 10−6, indicates a low correlation. This shows 

the importance of having a data set that covers the area of which the interpolation is carried out 
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on. The predicted values from the interpolated dose rate map using 50% of the data was 

compared with the measured values. Because the distribution of the 50% and 100% data are the 

same, this comparison would act as a good indication of how well the Empirical Bayesian 

Kriging method works for interpolation of discrete dose rate data. High correlation was found, 

where Pearson coefficient was r = 0.96 and R2 = 0.92. The predicted values extracted from the 

dose rate map produced from 50% of the data are largely in agreement with the measured 

values, suggesting this method works well.  
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Conclusion 

The committed effective dose received by the Swedish population from NORM in food 

was estimated to 77 ± 2 µSv/y for adults and 94 ± 9 µSv/y for children. The Swedes eating 

an animal protein including diet receive 4.5 times higher committed effective dose compared 

with those eating a lacto-ovo vegetarian diet, because of the general higher content of Po210  in 

fish and shellfish than in vegetable food. The overall effect of cooking led to a decrease in 

amount of Po210 . Swedish men receive 20% higher committed effective dose compared with 

Swedish women, due to different food habits.  

When varying the GI uptake fraction for Po210  extracted from recent data, the estimate 

of the committed effective dose received by Swedish adults differed by ± 9% from the dose 

calculated using the GI uptake fraction defined by ICRP. The updated tissue weighting factors 

from ICRP 133 gave a 23% higher estimate of the committed effective dose from Po210  

compared with the old factors from ICRP 68, which are the ones used in the calculation of the 

dose coefficient in ICRP 119. When using the sex dependent transfer rates between stomach 

and small intestine collected from ICRP 100, women received a higher committed equivalent 

dose to the stomach compared with men.  

In this study, the biokinetics of Po210  was simulated and the results suggest that the new 

development in the biokinetic models lead to a 5-18% higher estimate of the committed 

effective dose from NORM in food received by Swedish adults.  

Interpolation maps were done using the Empirical Bayesian Kriging method in the 

software ArcGIS 10.6. Measured and predicted values in respective coordinate were in good 

agreement, suggesting this method works well for this purpose.  
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Appendix A: Food consumption data 

In Appendix A the food consumption data, used in the dose estimation, are presented.  

 

Table A1: Food consumption data for Swedish adults from the Swedish Board of Agriculture [31]. The listed consumption data 

are averages of the consumptions during the years 2014, 2015 and 2016.  

Food/foodstuff kg/y 

Plum 3.13 

Apple 10.99 

Cucumber 6.27 

Potatoes 54.33 

Zucchini 8.80 

Carrots 10.83 

Broccoli 4.67 

Cauliflower 1.53 

Flour 8.17 

Blue Berries 4.83 

Onions 9.03 

Beetroot 1.93 

Tomato 9.87 

Milk 78.17 

Egg 11.33 

Mushroom 8.80 

Chicken 20.87 

Beef Mince 12.83 

Yoghurt 31.4 

Cabbage 4.67 

Bananas 21.47 

Pear 2.41 

Bread 52.43 

Oatmeal 3.53 

Strawberries 4.83 

Deer 1.67 

Wild Boar 1.67 

Sausage 14.73 

Lamb 1.33 

Orange 17.80 

Pork 15.07 

Turkey 20.87 

 

 



 

 

Table A2: Food consumption data for Swedish adults from the report Svensk konsumtion av sjömaten - en växande mångfald 

[30]. To get the consumption per capita, the total fish consumption in Sweden year 2015 was divided by 8133874 (the Swedish 

population in 2015, including adults and children from 15 years and up) [39].  

Type of fish 
Consumption 

(kg/y) 

Herrings 1.77 

Blue Mussel 0.05 

Cod 2.13 

Hake 0.11 

Saithe 0.68 

Mackerel 0.77 

Shrimp 0.77 

Pike-perch 0.0007 

Plaice 0.20 

 

Table A3: Relative food consumption data for children of ages 4, 12 and 15 years received from the Swedish National Food 

Agency [32, 33] compared with consumption data for adults received from the Swedish Board of Agriculture [31] and the 

report Svensk konsumtion av sjömaten - en växande mångfald [30]. The consumption data for children are averages between 

girls and boys. The uncertainties are given as SEM.  

Food Relative food consumption compared with adults 

4 y 12 y 15 y 

vegetables 0.30±0.01 0.80±0.02 0.95±0.02 

Root vegetables 0.23±0.02 0.51±0.04 0.46±0.03 

fruits and berries 0.59±0.02 0.36±0.02 0.42±0.02 

potatoes 0.53±0.01 0.56±0.02 0.60±0.02 

rice & grains 0.98±0.07 1.39±0.17 1.96±0.23 

bread 0.31±0.01 0.43±0.01 0.47±0.01 

milk  1.13±0.07 1.36±0.09 1.40±0.10 

yoghurt 1.06±0.09 0.76±0.04 0.66±0.04 

meat 0.66±0.02 0.59±0.02 0.62±0.02 

birds 0.21±0.02 0.52±0.04 0.59±0.04 

sausage 0.57±0.02 1.07±0.04 1.03±0.04 

fish & shellfish 0.56±0.04 0.68±0.06 0.90±0.07 

egg 0.19±0.02 0.15±0.04 0.21±0.05 

.     

 



 

 

 

Table A4: Food consumption for women and men received from the Swedish National Food Agency [34]. The uncertainties 

are given as SEM.  

Food Women (kg/y) Men (kg/y) Average (kg/y) 

vegetables & mushrooms 53.66±0.97 49.64±1.07 52.20±0.72 

fruits & berries 53.66±1.28 38.33±1.57 46.72±1.01 

potatoes 26.65±0.81 48.55±1.57 36.14±0.87 

root vegetables 8.40±0.40 7.30±0.53 8.03±0.32 

bread 27.38±0.48 37.23±0.72 31.76±0.43 

milk 50.74±1.98 64.97±3.23 56.94±1.80 

egg 5.11±0.32 5.11±0.44 5.11±0.26 

fish 13.51±0.46 15.70±0.70 14.24±0.40 

birds 7.30±0.37 8.40±0.56 8.03±0.33 

meat 18.25±0.40 29.2±0.70 23.00±0.41 

yoghurt 31.76±2.06 32.85±3.19 32.12±1.83 

oat meal 12.41±1.28 15.33±2.02 14.24±1.14 

sausage 5.48±0.32 10.22±0.53 7.67±0.30 

 

 

Table A5: World average food consumption received from the UNSCEAR 2008 report [3]. 

Food Consumption (kg/y) 

milk 105 

meat 50 

grains 140 

vegetables 60 

fruit & root vegetables 170 

fish 15 

 

 

 

 



 

 

Appendix B: The model used in SAAM II and Ecolego 

In Appendix B, the model is shown (Figure B1) and the transfer coefficients used in the 

simulation in SAAM II are presented (Table B1). 
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Table B1: The transfer coefficients [ 𝑑−1] used in the simulation in SAAM II. The coefficients in HATM are collected from 

ICRP 100 [15] and the coefficients in the systemic model are collected from ICRP 137 [18]. The coefficients for women are 

listed before those for men, when the values are different.  

k(0,1) physical decay ← right colon 0.0072 
 

k(0,4) physical decay ← plasma 3 0.0072 

k(0,10) physical decay ← gonads 0.0072  k(0,5) physical decay ← RBC 0.0072 

k(0,11) physical decay ← other 0.0072 
 

k(0,6) physical decay ← small intestine 0.0072 

k(0,12) physical decay ← kidney 1 0.0072 
 

k(0,7) physical decay ← left colon 0.0072 

k(0,13) physical decay ← kidney 2 0.0072 
 

k(0,8) physical decay ← liver 1 0.0072 

k(0,14) physical decay ← skin 0.0072 
 

k(0,9) physical decay ← liver 2 0.0072 

k(0,15) physical decay ← spleen 0.0072 
 

k(1,6) right colon ← small intestine 6 

k(0,16) physical decay ← red marrow 0.0072 
 

k(10,3) gonads ← plasma 1 0.05 0.1 

k(0,17) physical decay ← bone surface 0.0072 
 

k(11,3) other ← plasma 1 32.35 

k(0,18) physical decay ← urinary bladder 0.0072 
 

k(12,3) kidney 1 ← plasma 1 5 

k(0,19) physical decay ← urine 0.0072 
 

k(13,3) kidney 2 ← plasma 1 5 

k(0,20) physical decay ← hair, sweat 0.0072 
 

k(14,3) skin ← plasma 1 5 

k(0,21) physical decay ← rectosigmoidal 0.0072 
 

k(15,3) spleen ← plasma 1 2 

k(0,22) physical decay ← faeces 0.0072 
 

k(16,3) red marrow ← plasma 1 4 

k(0,23) physical decay ← stomach 0.0072 
 

k(17,3) bone surface ← plasma 1 1.5 

k(0,24) physical decay ← oesophagus slow 0.0072 
 

k(18,12) urinary bladder ← kidney 1 0.173 

k(0,25) physical decay ← oesophagus fast 0.0072 
 

k(19,18) urine ← urinary bladder 12 

k(0,26) physical decay ← oral cavity slow 0.0072 
 

k(20,14) sweat, hair ← skin 0.0069 

k(0,27) physical decay ← oral cavity fast 0.0072 
 

k(21,7) rectosigmoidal ← left colon 1.5 2 

k(0,3) physical decay ← plasma 1 0.0072 
 

k(22,21) faeces ← rectosigmoidal 1.5 2 

 

 

 

 

 

 



 

 

 

 Table B1 continuing 

   

k(23,24) stomach ← oesophagus slow 2160 

k(23,25) stomach ← oesophagus fast 12343 

k(24,26) oesophagus slow ← oral cavity slow 7200 

k(25,27) oesophagus fast ← oral cavity fast 7200 

k(3,10) plasma 1 ← gonads 0.0139 

k(3,11) plasma 1 ← other 0.099 

k(3,13) plasma 1 ← kidney 2 0.099 

k(3,14) plasma 1 ← skin 0.0069 

k(3,15) plasma 1 ← spleen 0.099 

k(3,16) plasma 1 ← red marrow 0.099 

k(3,17) plasma 1 ← bone surface 0.0231 

k(3,4) plasma 1 ← plasma 3 0.099 

k(3,5) plasma 1 ← RBC 0.099 

k(3,6) plasma 1 ← small intestine 0.6667 

k(3,9) plasma 1 ← liver 2 0.099 

k(4,3) plasma 3 ← plasma 1 4 

k(5,3) RBC ← plasma 1 6 

k(6,23) small intestine ← stomach 15.16 20.57 

k(6,8) small intestine ← liver 1 0.139 

k(7,1) left colon ← right colon 1.5 2 

k(8,3) liver 1 ← plasma 1 17.5 

k(9,3) liver 2 ← plasma 1 17.5 



 

 

Appendix C: S coefficients for 𝐏𝐨𝟐𝟏𝟎  

In Appendix C, the S coefficients for Po210  are presented. Acronyms for source and 

target regions are listed in Table C1. 

                                       Table C1: Acronyms for source and target regions [35]. 

 

 

 

 

Table C2: Female S coefficients (𝑆𝑣 (𝐵𝑞 𝑠)−1)  for 𝑃𝑜
210

. 

            Source 
Target  

blood C-bone-S T-bone-S R-marrow kidneys 

oral mucosa 
1.24E-13 0 0 0 0 

oeosophagus 
7.87E-13 0 0 0 0 

St stem 
7.87E-13 0 0 0 0 

SI stem 
8.55E-13 0 0 0 0 

Source/target region Acronym 

Stomach  St stem 

Small intestine SI stem 

Right colon RC stem 

Left colon LC stem 

Rectosigmoid colon RS stem 

ET1 basal cells ET1 bas 

ET2 basal cells ET2 bas 

Extrathoracic lymph nodes LN ET 

Bronchi basal cells bronch bas 

Bronchi secretary cells bronch sec 

Bronchiolar secretary cells bchiol sec 

Alveolar-interstitial AI 

Thoracic lymph nodes LN th 

Red marrow R-marrow 

Endosteal cells Endost-BS 

Pituitary gland p-gland 

Salivary glands s-glands 

Heart wall Ht-wall 

Gall bladder GB-wall 

Urinary bladder UB-wall 

Systemic lymph nodes LN-sys 

Cortical bone surface C-bone-S 

Trabecular bone surface T-bone-S 



 

 

RC stem 
8.31E-13 0 0 0 0 

LC stem 
8.31E-13 0 0 0 0 

RS stem 
8.31E-13 0 0 0 0 

ET1 bas 
1.24E-13 0 0 0 0 

ET2 bas 
1.24E-13 0 0 0 0 

LN ET 
2.25E-13 0 0 0 0 

bronch bas 
6.77E-13 0 0 0 0 

bronch sec 
6.77E-13 0 0 0 0 

bchiol sec 
6.77E-13 0 0 0 0 

AI 
2.33E-12 0 0 0 0 

LN th 
2.25E-13 0 0 0 0 

R-marrow 
6.39E-13 0 2.59E-12 1.0E-11 0 

Endost-BS 
2.42E-13 2.92E-12 1.96E-11 4.5E-12 0 

brain 
1.51E-13 0 0 0 0 

eye lence 
0 0 0 0 0 

p-gland 
1.24E-13 0 0 0 0 

tongue 
1.24E-13 0 0 0 0 

tonsills 
1.24E-13 0 0 0 0 

s-glands 
1.24E-13 0 0 0 0 

thyroid 
5.24E-13 0 0 0 0 

breast 
1.24E-13 0 0 0 0 

thymus 
1.24E-13 0 0 0 0 

Ht-wall 
5.84E-13 0 0 0 0 

adrenals 
6.60E-13 0 0 0 0 

liver 
9.39E-13 0 0 0 0 

pancreas 
7.05E-13 0 0 0 0 

kidneys 
9.52E-13 0 0 0 4.76E-11 



 

 

spleen 
1.27E-12 0 0 0 0 

GB-wall 
1.24E-13 0 0 0 0 

ureters 
1.24E-13 0 0 0 0 

UB-wall 
8.33E-14 0 0 0 0 

ovaries 
5.38E-13 0 0 0 0 

testes 
0 0 0 0 0 

prostate 
0 0 0 0 0 

uterus 
1.24E-13 0 0 0 0 

LN-sys 
2.25E-13 0 0 0 0 

skin 
2.10E-13 0 0 0 0 

adipose 
6.64E-14 0 0 0 0 

muscle 
9.95E-14 0 0 0 0 

 

 

Table C3: Female S coefficients (𝑆𝑣 (𝐵𝑞 𝑠)−1)  for 𝑃𝑜
210

, continuing. 

            Source 
Target  

liver ovaries skin spleen UB cont  other 

oral mucosa 
0 0 0 0 0 3.53E-13 

oeosophagus 
0 0 0 0 0 2.85E-13 

St stem 
0 0 0 0 0 6.29E-13 

SI stem 
0 0 0 0 0 6.29E-13 

RC stem 
0 0 0 0 0 5.47E-13 

LC stem 
0 0 0 0 0 5.39E-13 

RS stem 
0 0 0 0 0 5.33E-13 

ET1 bas 
0 0 0 0 0 3.15E-13 

ET2 bas 
0 0 0 0 0 6.28E-13 

LN ET 
0 0 0 0 0 3.33E-13 

bronch bas 
0 0 0 0 0 6.94E-13 



 

 

bronch sec 
0 0 0 0 0 7.83E-13 

bchiol sec 
0 0 0 0 0 5.85E-13 

AI 
0 0 0 0 0 5.07E-13 

LN th 
0 0 0 0 0 3.33E-13 

R-marrow 
0 0 0 0 0 3.08E-13 

Endost-BS 
0 0 0 0 0 4.6E-13 

brain 
0 0 0 0 0 3.39E-13 

eye lence 
0 0 0 0 0 3.52E-13 

p-gland 
0 0 0 0 0 3.42E-13 

tongue 
0 0 0 0 0 3.42E-13 

tonsills 
0 0 0 0 0 3.42E-13 

s-glands 
0 0 0 0 0 3.42E-13 

thyroid 
0 0 0 0 0 3.08E-13 

breast 
0 0 0 0 0 3.42E-13 

thymus 
0 0 0 0 0 3.42E-13 

Ht-wall 
0 0 0 0 0 3.03E-13 

adrenals 
0 0 0 0 0 2.96E-13 

liver 
9.39E-12 0 0 0 0 0 

pancreas 
0 0 0 0 0 2.92E-13 

kidneys 
0 0 0 0 0 0 

spleen 
0 0 0 9.07E-11 0 0 

GB-wall 
0 0 0 0 0 3.43E-13 

ureters 
0 0 0 0 0 3.42E-13 

UB-wall 
0 0 0 0 2.01E-13 3.45E-13 

ovaries 
0 1.44E-09 0 0 0 0 

testes 
0 0 0 0 0 0 

prostate 
0 0 0 0 0 0 



 

 

uterus 
0 0 0 0 0 3.42E-13 

LN-sys 
0 0 0 0 0 3.34E-13 

skin 
0 0 7.01E-12 0 0 0 

adipose 
0 0 0 0 0 3.47E-13 

muscle 
0 0 0 0 0 3.44E-13 

 

 

Table C4: Male S coefficients (𝑆𝑣 (𝐵𝑞 𝑠)−1)  for 𝑃𝑜
210

. 

            Source 
Target  

blood C-bone-S T-bone-S R-marrow kidneys 

oral mucosa 
1.36E-13 0 0 0 0 

oeosophagus 
6.91E-13 0 0 0 0 

St stem 
6.91E-13 0 0 0 0 

SI stem 
7.49E-13 0 0 0 0 

RC stem 
7.58E-13 0 0 0 0 

LC stem 
7.58E-13 0 0 0 0 

RS stem 
7.58E-13 0 0 0 0 

ET1 bas 
1.36E-13 0 0 0 0 

ET2 bas 
1.36E-13 0 0 0 0 

LN ET 
1.79E-13 0 0 0 0 

bronch bas 
5.55E-13 0 0 0 0 

bronch sec 
5.55E-13 0 0 0 0 

bchiol sec 
5.55E-13 0 0 0 0 

AI 
1.80E-12 0 0 0 0 

LN th 
1.79E-13 0 0 0 0 

R-marrow 
4.88E-13 0 1.98E-12 7.6E-12 0 

Endost-BS 
1.86E-13 2.19E-12 1.46E-11 3.4E-12 0 

brain 
1.34E-13 0 0 0 0 



 

 

eye lence 
0 0 0 0 0 

p-gland 
1.36E-13 0 0 0 0 

tongue 
1.36E-13 0 0 0 0 

tonsills 
1.36E-13 0 0 0 0 

s-glands 
1.36E-13 0 0 0 0 

thyroid 
4.37E-13 0 0 0 0 

breast 
1.36E-13 0 0 0 0 

thymus 
1.36E-13 0 0 0 0 

Ht-wall 
4.40E-13 0 0 0 0 

adrenals 
5.88E-13 0 0 0 0 

liver 
7.20E-13 0 0 0 0 

pancreas 
5.88E-13 0 0 0 0 

kidneys 
8.05E-13 0 0 0 4.03E-11 

spleen 
1.04E-12 0 0 0 0 

GB-wall 
1.36E-13 0 0 0 0 

ureters 
1.36E-13 0 0 0 0 

UB-wall 
6.65E-14 0 0 0 0 

ovaries 
0 0 0 0 0 

testes 
1.83E-13 0 0 0 0 

prostate 
1.36E-13 0 0 0 0 

uterus 
0 0 0 0 0 

LN-sys 
1.79E-13 0 0 0 0 

skin 
1.47E-13 0 0 0 0 

adipose 
4.85E-14 0 0 0 0 

muscle 
7.99E-14 0 0 0 0 

 



 

 

Table C5: Male S coefficients (𝑆𝑣 (𝐵𝑞 𝑠)−1)  for 𝑃𝑜
210

, continuing. 

            Source 
Target  

liver skin spleen UB cont testes  other 

oral mucosa 
0 0 0 0 0 2.95E-13 

oeosophagus 
0 0 0 0 0 2.28E-13 

St stem 
0 0 0 0 0 5.16E-13 

SI stem 
0 0 0 0 0 5.17E-13 

RC stem 
0 0 0 0 0 4.4E-13 

LC stem 
0 0 0 0 0 4.43E-13 

RS stem 
0 0 0 0 0 4.35E-13 

ET1 bas 
0 0 0 0 0 2.63E-13 

ET2 bas 
0 0 0 0 0 5.25E-13 

LN ET 
0 0 0 0 0 2.77E-13 

bronch bas 
0 0 0 0 0 5.83E-13 

bronch sec 
0 0 0 0 0 6.58E-13 

bchiol sec 
0 0 0 0 0 4.93E-13 

AI 
0 0 0 0 0 4.23E-13 

LN th 
0 0 0 0 0 2.77E-13 

R-marrow 
0 0 0 0 0 2.89E-13 

Endost-BS 
0 0 0 0 0 4.06E-13 

brain 
0 0 0 0 0 2.82E-13 

eye lence 
0 0 0 0 0 2.95E-13 

p-gland 
0 0 0 0 0 2.82E-13 

tongue 
0 0 0 0 0 2.82E-13 

tonsills 
0 0 0 0 0 2.82E-13 

s-glands 
0 0 0 0 0 2.82E-13 

thyroid 
0 0 0 0 0 2.53E-13 

breast 
0 0 0 0 0 2.82E-13 



 

 

thymus 
0 0 0 0 0 2.82E-13 

Ht-wall 
0 0 0 0 0 2.52E-13 

adrenals 
0 0 0 0 0 2.38E-13 

liver 
7.20E-12 0 0 0 0 0 

pancreas 
0 0 0 0 0 2.38E-13 

kidneys 
0 0 0 0 0 0 

spleen 
0 0 7.44E-11 0 0 0 

GB-wall 
0 0 0 0 0 2.83E-13 

ureters 
0 0 0 0 0 2.82E-13 

UB-wall 
0 0 0 1.60E-13 0 2.89E-13 

ovaries 
0 0 0 0 0 0 

testes 
0 0 0 0 4.56E-10 0 

prostate 
0 0 0 0 0 2.82E-13 

uterus 
0 0 0 0 0 0 

LN-sys 
0 0 0 0 0 2.77E-13 

skin 
0 4.90E-12 0 0 0 0 

adipose 
0 0 0 0 0 2.9E-13 

muscle 
0 0 0 0 0 2.87E-13 

 



 

 

Appendix D: ArcGIS manual for interpolation using the 

Empirical Bayesian Kriging method 

 

ArcGIS ArcMap 10.6 manual for interpolation  

using the Empirical Bayesian Kriging method 

 

Preparation of the data file 

Create a file in .csv format consisting of three columns: the longitude coordinates, the latitude 

coordinates and the data you want to interpolate i.e. dose rate or activity concentration.  

 

How to import data into ArcMap 

1. Click Catalog > Folder connections and right click to connect the catalog to the folder in your 

computer where your data are stored. 

 

 

 

 

 

 

 

 



 

 

2. Click Add data and add the data file. 

 

 

3. The added data file is now displayed in Table of contents. Right click on the data and choose 

display XY data. Make sure the longitude data are interpreted as X Field, the latitude data as Y 

Field and the dose rate/activity concentration data as Z Field. Click Edit > Geographic coordinate 

systems and choose the coordinate system your data are expressed in (WGS 84 is found in the 

folder World). After you have clicked OK twice, the data can now be shown graphically. It may 

pop up a box that says “your data has no object ID” – click OK.  

 

 



 

 

 

 

4. Import a geographical map by clicking File > Add data > Add Basemap and choose the map you 

prefer. The geographical map is now listed in Table of contents and must be at the bottom of the 

list, otherwise your dose rate data will not be shown in the graphical view.  

 

 

 

Interpolation using the Empirical Bayesian Kriging method 

Using the EBK method, there are some options to make. In EBK, the data are divided 

into subsets to make the calculation faster [28]. The number of subsets can be selected by the 

user as well as the overlap factor and the number of simulations. The overlap factor is deciding 

to what extent the subsets are to be overlapping and the higher value the smoother the 

interpolation gets and the longer time it takes. The number of simulations, i.e. the number of 

simulated semivariogram per subsets, can be selected and the more simulations the more 

accurate gets the interpolation but the longer time it takes. In some geostatistical methods for 

interpolation, the data must be normal distributed. In EBK, there is an option for making the 



 

 

data normal distributed by using a transformation (Empirical or Log Empirical). Anyway, there 

is no need to have normal distributed data when making a predicted surface map and therefore 

the choice should be to not make a transformation. There are three different types of functions, 

for fitting of the semivariogram, to choose between; Power, Linear and Thin Plate Spline. 

Power is default because it is relatively fast and give generally good accuracy. Linear can be 

chosen if the interpolation is to be faster and a bit less accurate and Thin Plate Spline is 

appropriate if there is a strong trend in the data. 

The user can choose between standard circular or smooth circular when deciding which 

surrounding data points to be used for the prediction [28]. When using standard circular, the 

surrounding data points are chosen if they are within a certain radius (which can be chosen by 

the user). The largest and the smallest number of data points used in the calculation can be set 

by the user. When using smooth circular, one small ellipse and one larger outer ellipse are 

created. If the data points are inside the small ellipse, they are included for the prediction. The 

data points that are between the ellipses will be weighted with a factor between 0 and 1 before 

they are included in the calculation. Standard circular is the default method and smooth circular 

takes longer time.  

 

Click Customize > Extensions and check the box for Geostatistical Analyst. Then click 

Customize > Toolbars > Geostatistical Analyst and the toolbar will appear on the workspace.  

1. Click Geostatistical Analyst > Geostatistical Wizard and choose Empirical Bayesian Kriging. 

 

 
 

2. Select your data file followed by “Events” as your Source Dataset and the column with your dose 

rate/ activity concentration data as your Data field. Click Next. 

3. A box will come up if your file consists of data points having the same coordinates, here you can 

choose to make the software taking the mean value of those points. 

4. The next step is showing the Method properties, here you can change the properties or use the default 

selections. Click Next. 

5. The last step is showing some statistics of the interpolation, click Finish.  

 



 

 

 
 

6. Unmark the box for your discrete data in the Table of Contents. 

7. Double click on Filled colours under the Empirical Bayesian Kriging Prediction Map in the Table 

of Contents. Under the tab Display you can change the transparency of the predicted map.  

8. Choose Layout View and Click File > Export Map to save your map as a file, for example in .png 

format. 

 

 
 

 

 

 

 

 

 



 

 

The finished interpolated map is shown below. 

 

 

 


